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Техника безопасности
• Внимательно прочтите руководство.

• Следуйте всем инструкциям, изложенным в руководстве пользователя.

• Строго выполняйте все требования, изложенные в руководстве пользователя.

• Не располагайте прибор вблизи воды.

• Протирайте прибор только сухой материей.

• Производите установку оборудования согласно требованиям производителя.

• Не устанавливайте прибор вблизи источников тепла, таких как радиаторы, батареи и другой аппаратуры 
(включая усилители), излучающей тепло.

• Отключайте прибор от сети во время грозы и при длительных перерывах в эксплуатации.

• Не пользуйтесь сетевыми шнурами и розетками с поврежденными элементами заземления.

• Оберегайте сетевой шнур от повреждений и скручивания, особенно вблизи соединительных разъемов.

• При инсталляциях применяйте только сертифицированное профессиональное оборудование и аксессуары.

• Пользуйтесь услугами только квалифицированных специалистов в следующих случаях:

• Повреждение сетевого шнура.

• Попадание жидкости внутрь прибора.

• Нарушение нормальной работы прибора.

• Повреждение корпуса прибора.

• Попадание прибора под дождь.

• Для включения/отключения питания прибора предназначен специальный переключатель. Не производите 
включение/отключение питания с помощью подсоединения вилки к розетке или отсоединения от нее.

• В целях снижения электромагнитных помех для коммутации с внешним оборудованием используйте только 
экранированные кабели.

Äàííûé ñèìâîë îçíà÷àåò, ÷òî îòìå÷åííîå èì èçäåëèå 
äîëæíî óòèëèçèðîâàòüñÿ îòäåëüíî îò äîìàøíèõ îòõîäîâ, 

ñîãëàñíî ïðèíÿòîìó â êîíêðåòíîé ñòðàíå çàêîíîäàòåëüñòâó. 
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Введение
Поздравляем с приобретением настольного аудиоинтерфейса Lexicon IO 22! 

Запатентованная конструкция IO 22 обеспечивает высококачественную связь между различными источниками 
сигнала и мониторами, а также управление уровнями всех сигналов. 

Благодаря наличию в каждом канале усовершенствованных высокомощных микрофонных предусилителей dbx с 
низким уровнем шумов, IO 22 представляет собой уникальное решение для профессиональной звукозаписи. 
Питание предусилителей осуществляется от источника напряжением 60 В, что гарантирует стабильность работы 
в широком динамическом диапазоне. В свою очередь, преобразователи А/Ц - Ц/А поддерживают формат 
24 бит/96 кГц, обеспечивающий неискаженную передачу всех звуковых нюансов исполнения. 

Название брэнда Lexicon является синонимом “самого качественного ревербератора”. В плагине 
Pantheon II VST/AU представлено 6 типов реверберации с 16 настраиваемыми параметрами и 35 заводских 
пресетов для обработки различных источников сигнала — от вокала до концертного звука, а также спецэффекты. 
Lexicon помогает создавать великолепно звучащие музыкальные миксы, обрабатывая их прославившими Lexicon 
эффектами реверберации. 

Основные характеристики
• Мощные микрофонные предусилители dbx с низким уровнем шумов.

• 2 аналоговых микрофонных/линейных входа на комбинированных разъемах.

• 1 инструментальный вход 1/4".

• 2 аналоговых выхода 1/4" TRS.

• 1 выход на наушники с независимым регулятором громкости.

• Вход и выход MIDI.

• Аудиоинтерфейс USB 2.0.

• Частота дискретизации от 44.1 до 96 кГц, разрешение 24 бит.

Распаковка и проверка
Аудиоинтерфейс IO 22 поставляется в заводской упаковке, содержащей сам прибор IO 22 и DVD с программным 
обеспечением для Windows и Macintosh. Сохраните упаковку для транспортировки прибора в дальнейшем. Если в 
процессе осмотра IO 22 и упаковки обнаружены следы повреждений, обратитесь к дилеру, у которого было 
приобретено изделие.

Комплект поставки
• Настольный аудиоинтерфейс IO 22.

• Диск DVD с драйверами и программным обеспечением для Windows и Mac: плагин реверберации Lexicon 
Pantheon II, плагин XILS3 SE, Cubase LE и ToonTrack EZ Drummer Lite.

• Кабель USB.

• Гарантийный талон Lexicon.

• Сетевой адаптер. 

* Руководство пользователя на Cubase LE находится на прилагаемом диске DVD. 
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Системные требования
Чтобы обеспечить бесперебойную работу устройства IO 22, необходимо использование компьютера и 
операционной системы, требования к которым изложены ниже. 

Windows Vista, XP, 7 (минимальные требования) 
• Многоядерный процессор 

• 1 Гб памяти RAM 

• Разрешение экрана 1024 x 768 точек 

• Привод DVD-ROM

• Доступ в Интернет для активации лицензии на программное обеспечение

Mac (минимальные требования) 
• Процессор Intel 

• 1 Гб памяти RAM 

• OS X версии 10.4.9 или старше (см. веб-сайт www.lexiconpro.com) 

• Разрешение экрана 1024 x 768 точек 

• Привод DVD-ROM

• Доступ в Интернет для активации лицензии на программное обеспечение

* Для просмотра находящейся на диске DVD документации в формате pdf требуется программа Adobe Reader.

Лицевая панель

1. Измерители уровней входных сигналов 
Эти светодиодные линейки показывают уровни сигналов на каждом из входов и оставшийся запас по усилению. 
Они имеют следующую градацию:

Красный Перегрузка (клиппирование)

Желтый –3 дБ
Зеленый –6 дБ

Зеленый –9 дБ

Зеленый –12 дБ
Зеленый –18 дБ

Зеленый –24 дБ

Зеленый –36 дБ

1 2

3 4 5 6 7 8 9 10 11
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2. Измерители уровней выходных сигналов 
Эти светодиодные линейки показывают уровни сигналов на каждом из выходов и оставшийся запас по усилению. 
Они имеют следующую градацию:

3. Регулятор PHONES
Служит для установки громкости в наушниках.

4. Регулятор MIC/LINE/INST 1
Служит для установки уровня усиления на входах Mic/Line 1 или Instrument. 

5. Индикатор INSTRUMENT
Загорается при подключении джека 1/4" к разъему Instrument боковой панели. 

6. Кнопка и индикатор STEREO
Служит для выбора режима Stereo или Mono для входов Mic/Line 1 (или Instrument) и Mic/Line 2. Индикатор 
загорается при выборе режима Stereo. 

В режиме Stereo (индикатор STEREO горит) сигналы входов Instrument и Mic/Line 1 подаются на выход Left Main, 
а сигналы входа Mic/Line 2 — на выход Right Main. 

В режиме Mono (индикатор STEREO не горит) сигналы каждой пары входов микшируются и подаются на выходы 
Left и Right Main в качестве моносигнала. К паре относятся входы Mic/Line 1 и Mic Line 2. 

Выбор режима Stereo или Mono не воздействует на сигналы, подаваемые в компьютер.

7. Индикатор 48V
Загорается при подаче фантомного питания на пару входов Mic/Line 1 и 2. Фантомное питание для этой пары 
входов включается кнопкой 48V тыльной панели. Для работы большинства конденсаторных микрофонов требуется 
фантомное питание, при подключении динамических микрофонов его необходимо отключать. Обращайтесь к 
документации на используемый микрофон. 

8. Регулятор MIC/LINE 2
Служит для установки уровня усиления на входе Mic/Line 2. 

9. Регулятор OUTPUT LEVEL
Служит для установки уровня на главных входах Left и Right. 

10. Регулятор MONITOR MIX
IO 22 реализует возможность мониторинга входных сигналов непосредственно с аналоговых входов до их подачи 
в программу записи, что позволяет исключить задержку сигнала (латентность), возникающую вследствие его 
обработки в преобразователях и компьютере. Режим мониторинга устанавливается регулятором Monitor Mix, 
который осуществляет выбор между сигналами с аналоговых входов (положение “Direct”) и сигналами, 
поступающими из компьютера по USB (положение “Playback”). Для мониторинга только входных сигналов IO 22 
установите регулятор в положение Direct. Для мониторинга только сигналов компьютера установите регулятор в 
положение Playback. Сигналы после регулятора Monitor Mix подаются на главные выходы и на наушники. 

11. Индикатор USB
Загорается при установке связи с компьютером по USB. 

Красный Перегрузка (клиппирование)

Желтый –3 дБ
Зеленый –6 дБ

Зеленый –9 дБ

Зеленый –12 дБ
Зеленый –18 дБ

Зеленый –24 дБ

Зеленый –36 дБ
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Тыльная и боковые панели

1. Разъем INSTRUMENT
Несимметричный вход 1/4” служит для подключения источников инструментального уровня (например, гитар). 
Имейте в виду, что при задействовании разъема Instrument вход Mic/Line 1 отключается.

2. Переключатель POWER
Включает/отключает питание IO 22. 

3. Разъем POWER
Служит для подключения прилагаемого сетевого адаптера. 

4. Порт USB
Служит для подключения IO 22 к компьютеру прилагаемым стандартным кабелем USB. 
IO 22 совместим только с протоколом USB 2.0. 

5. Разъемы MIDI IN и OUT
Служат для обмена MIDI-сообщениями с компьютером, синтезаторами, звуковыми модулями и внешними 
контроллерами. 

6. Разъемы MAIN OUTPUTS
Выходные разъемы, поддерживающие коммутацию симметричными TRS или несимметричными TS джеками 1/4”. 
Они могут подключаться к входам микшерной консоли, усилителя мощности, активных мониторов, рекордера и 
других устройств, имеющим линейный уровень. При коммутации с симметричным оборудованием рекомендуется 
использовать симметричные кабели. 

7. Разъемы MIC/LINE INPUTS 1 – 2
Симметричные входы на комбо-разъемах XLR и 1/4” служат для подключения микрофонов и источников сигналов 
линейного уровня. Имейте в виду, что при задействовании разъема Instrument вход Mic/Line 1 отключается.

8. Кнопка 48V для MIC/LINE 1 и MIC/LINE 2 
Служит для подачи фантомного питания на входы Mic/Line 1 и Mic/Line 2. Когда она включена, загорается 
индикатор +48V, расположенный на лицевой панели между регуляторами Mic/Line/Inst 1 и 2. Для работы 
большинства конденсаторных микрофонов требуется фантомное питание, при подключении динамических 
микрофонов или любых источников сигналов линейного уровня его необходимо отключать. Обращайтесь к 
документации на используемый микрофон. 

9. Разъем PHONES
Служит для подключения стереонаушников с разъемом 1/4" TRS. Сигналы на этом разъеме аналогичны выходным 
сигналам на разъемах Main Outputs, но имеют независимый регулятор уровня. 

1 32 4 5 6 7 8 9
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Коммутация
Пример коммутации

Микрофоны
Подключите микрофон кабелем XLR к выбранному входу Mic/Line тыльной панели IO 22.  

Если микрофон требует использование фантомного питания, после его подключения подайте его с помощью 
кнопки +48V тыльной панели. В любом другом случае не включайте эту кнопку. 

* При подаче фантомного питания на микрофон, для которого оно не требуется, микрофон может быть 
поврежден. Обращайтесь к документации на используемый микрофон. 

Источники сигналов линейного уровня
К таким источникам относятся синтезаторы, ритм-машины, плееры CD, внешние микрофонные предусилители и 
процессоры эффектов. Подключайте источники сигналов линейного уровня кабелем 1/4" TS (несимметричным) 
или TRS (симметричным) к выбранному входу Mic/Inst тыльной панели IO 22.  

Инструменты
К инструментам в первую очередь относятся электрогитары и бас-гитары. Подключите гитару стандартным 
несимметричным кабелем 1/4" TS (инструментальным) к входу Instrument боковой панели IO 22. 

Компьютер/программа DAW
Подключите порт USB компьютера к порту USB тыльной панели IO 22 прилагаемым стандартным кабелем USB. 

Наушники
Подключите стереонаушники к разъему Phones боковой панели. Наушники должны быть оборудованы разъемом 
1/4" TRS. Громкость в наушниках устанавливается регулятором Phones. 

Система мониторинга
С помощью кабелей 1/4" подключите разъемы L/R Main Output тыльной панели к входам микшерной консоли, 
усилителя мощности или активных мониторов. Выходной уровень устанавливается регулятором Output Level. При 
коммутации с симметричным оборудованием рекомендуется использовать симметричные кабели.

Кабель USB

Компьютер

Мониторы

Наушники

Микрофон
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Пример проекта IO 22 — запись гитары 
Для начала работы и ознакомления с IO 22 выполните приведенные ниже шаги. В данном примере используется 
Cubase LE, но IO 22 также поддерживает работу с большинством существующих приложений DAW.

Установка программного обеспечения

1. Вставьте диск DVD в привод DVD-ROM. Программа установки запустится автоматически.
Если этого не произошло, запустите программу установки вручную, открыв необходимый файл на DVD:

Mac: Open Me

Windows: InstallationMenu.exe 

2. Следуя экранным инструкциям, установите необходимое программное обеспечение.
Чтобы компьютер смог распознать IO 22, необходимо установить соответствующие драйверы. Также для 
выполнения изложенной далее процедуры необходимо установить Cubase LE. Последние версии драйверов 
можно найти на сайте www.lexiconpro.com.

Активация Cubase LE
1. Установите Cubase LE.

2. Запустите Cubase LE и нажмите “Register Now” или перейдите на сайт 
www.steinberg.net/en/mysteinberg.

3. Следуя экранным инструкциям, создайте эккаунт MySteinberg и войдите в MySteinberg.

4. В секции Activation & Reactivation выберите свою версию Cubase LE, затем в секции 
Permanent Activation нажмите “More”.

5. Введите номер лицензии (Sel Nr.). Чтобы узнать его, перейдите в eLicenser Control Center следующим 
образом: 
Windows: Start > All Programs > Syncrosoft > eLicenser Control Center.

Mac: Applications > eLicenser Control Center.

6. В поле Hardware Manufacturer выберите Lexicon и нажмите на “RequestActivation Code”.

7. Скопируйте код активации.

Номер лицензии
(20 символов)

Код активации
(32 символа)
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8. Вернитесь к окну eLicenser Control Center (см. шаг 5) и нажмите на “Enter Activation Code”.

9. Введите код активации, нажмите на “Continue” и затем на “Download License”.

10. После загрузки лицензии нажмите на “Close”.

Дополнительные установки Windows 
После установки драйверов и панели управления Windows автоматически будет использовать аудио- и MIDI-
выходы IO 22 в качестве устройств по умолчанию. Соответственно, все звуки Windows будут воспроизводиться 
через IO 22, а не через звуковую плату компьютера. Чтобы восстановить прежние установки, выполните 
следующую процедуру. 

1. Выберите Start > Control Panel > Sound and Audio Devices (XP) или Hardware and Sound (Vista/7). 

2. Выберите ярлык Audio (XP) или Manage Audio Devices (Vista/7). 

3. В секции Sound Playback > Default device (XP) или Playback (Vista/7) в качестве устройства по 
умолчанию выберите звуковую плату компьютера. 

4. В секции Sound Recording > Default device (XP) или Recording (Vista/7) в качестве устройства по 
умолчанию выберите звуковую плату компьютера.

5. В секции MIDI Music Playback > Default device в ниспадающем меню в качестве устройства по 
умолчанию выберите Microsoft GS Wavetable Synth (только для XP). 

Пример коммутации

Кабель USB

Компьютер

Наушники
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Подключение гитары

1. Установите в минимум регулятор Mic/Line/Inst 1. 

2. Подключите гитару к входу Instrument боковой панели.

Подключение наушников

3. Установите в минимум регулятор Phones.

Регулятор MIC/LINE/INST 1

Разъем INSTRUMENT

Регулятор PHONES
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4. Подключите наушники к разъему Phones боковой панели.

Подключение компьютера
5. Подключите порт USB компьютера к порту USB тыльной панели IO 22 прилагаемым кабелем USB.

Прослушивание звука гитары
1. Наденьте наушники.

2. Установите регулятор Monitor Mix в положение на “12 часов”. Это позволит прослушивать с 
одинаковым уровнем сигналы с входа IO 22 и из Cubase. 

3. Играя на гитаре, вращайте входной регулятор Line 1 вправо, контролируя уровень сигнала по 
соответствующему измерителю. 

4. Вращайте регулятор Phones вправо, чтобы установить комфортный уровень сигнала в наушниках. 

Разъем PHONES

Кабель USB
Компьютер
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Установки Cubase LE для IO 22 (Windows) 

1. Подключите IO 22 к компьютеру прилагаемым кабелем USB и включите питание IO 22. 

2. Запустите Cubase LE (меню Start, секция Lexicon). 

3. Если откроется следующее окно, нажмите OK. 

4. В программе Cubase LE выберите Devices > Device Setup. 

5. В меню Devices нажмите на VST Audio System и выберите Lexicon IO 22 в ниспадающем меню 
ASIO Driver. Нажмите на Switch, чтобы переключить драйвер, затем нажмите OK в диалоговом окне 
Device Setup. 

Теперь можно начать запись с IO 22 в Cubase LE. 

* В некоторых случаях можно повысить производительность системы, если выбрать большую величину 
латентности в ниспадающем меню System Performance панели управления ASIO (Devices > Device Setup > 
Lexicon IO 22 > Control Panel > ASIO).
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Установки Cubase LE для IO 22 (Mac)

1. Подключите IO 22 к компьютеру прилагаемым кабелем USB и включите питание IO 22. 

2. Запустите Cubase LE (в папке Applications) и откройте окно Devices > Device Setup, показанное ниже. 

3. Нажмите на VST Audio System и выберите Lexicon IO 22 в ниспадающем меню ASIO Driver. 

4. Cubase LE выдаст запрос на переключение драйвера. Выберите Switch, затем нажмите OK. 

5. Чтобы активировать драйвер, нажмите Reset, затем — OK. 

Только для Mac OS 10.4.x: после выбора Lexicon IO 22 в качестве ASIO Driver возможно придется проверить, 
активны ли входы выбранного устройства. Для этого выполните следующую процедуру: 

1. В меню выберите Device > VST Connections. 

2. В панели VST Connections нажмите ярлык Inputs. 

3. Если в поле под колонкой Audio Device отображается “Not Connected”, нажмите на него и выберите 
Lexicon IO 22, чтобы активировать входы IO 22. 

4. Закройте окно VST Connections. 

Теперь можно начать запись с IO 22 в Cubase LE. 
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Запись трека в Cubase LE 

Создание нового проекта

1. В меню Cubase выберите File > New Project. Откроется окно New Project. 

2. Выберите Lexicon IO 22 Mono In и нажмите OK. 

3. Выберите папку для сохранения проекта и нажмите Choose. 

4. Добавьте монотрек с помощью Project -> Add Track -> Audio. Выберите конфигурацию Mono и нажмите 
OK. 

5. В окне Audio 1 кнопка Record Enable должна быть окрашена в красный цвет. Если это не так, нажмите 
на нее. 

6. В окне Audio 1 нажмите кнопку Input Monitoring, чтобы она погасла.

Запуск записи
1. Нажмите кнопку Record в секции транспорта Cubase. 

2. Играйте на гитаре. 

Кнопка Record
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3. По окончании записи нажмите кнопку Stop. 

Воспроизведение результатов записи
1. Нажмите кнопку Go to Zero в секции транспорта Cubase. 

2. В IO 22 установите в минимум регулятор Phones. 

3. Наденьте наушники. 

4. Нажмите кнопку Play в секции транспорта Cubase. 

5. Вращайте регулятор Phones в IO 22 вправо, чтобы установить комфортный уровень сигнала в 
наушниках. 

После добавления трека в проект Cubase в поле Input Routing по умолчанию будет установлено IO 22 In 1. Однако, 
при подключении инструментов к другим входам IO 22 необходимо изменить входную маршрутизацию для других 
записываемых треков. В таблице приведено соответствие обозначений входов в Cubase LE физическим входам 
на IO 22.

Микширование аудиоматериала
С помощью микширования можно преобразовать проект Cubase в файл формата wav, который в свою очередь 
можно записать на CD или воспроизводить с помощью компьютера. Cubase LE не поддерживает микширование в 
формат mp3. Для преобразования файла формата wav в формат mp3 необходимо воспользоваться другими 
программами. 

Чтобы смикшировать проект, сначала установите левый и правый локаторы. Это можно сделать, нажав 
[Ctrl] + [A] и затем [P] на клавиатуре компьютера. Также можно перетащить маркеры мышкой в любую позицию. 

Установив локаторы, выберите меню File > Export > Audio mixdown. Нажмите кнопку “Choose”, введите имя файла 
в поле “File name”, в поле “Look in” задайте папку для сохранения файла формата wav и нажмите кнопку “Save”. 
Перед записью на CD файл необходимо сохранить на жесткий диск компьютера. 

Далее в поле “File Format” выберите Wave File (.wav), установите “Sample Rate” в 44.1 kHz, установите “Bit Depth” 
в 16 bit и нажмите Export. 

Возможности Cubase LE
Cubase LE предлагает множество функций и опций для записи, редакции и микширования аудиоматериала. Чтобы 
ознакомиться с ними, обращайтесь к документации на Cubase LE в меню Help > Documentation.

Вход IO 22 Обозначения входов монотреков в Cubase LE (для шаблона Lexicon IO 22 Mono In) 
1 IO 22 In 1 

2 IO 22 In 2 

Кнопка Stop

Кнопка Go to Zero

Кнопка Play
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Использование Pantheon II Reverb в Cubase LE
Плагин реверберации Pantheon II можно использовать в Cubase LE двумя способами: в разрыве аудиотрека или 
в канале FX.

Использование Pantheon II в разрыве аудиотрека:

1. Включите питание IO 22 и подключите его к компьютеру (Pantheon II активируется только после 
распознавания компьютером IO 22). 

2. Нажмите ярлык Inserts для выбранного канала. 

3. Нажмите на пустой слот и выберите Earlier VST Plug-ins > Lexicon > Pantheon II. Эффект реверберации 
Pantheon II будет воздействовать только на выбранный трек. 

Использование Pantheon в канале FX:

1. Включите питание IO 22 и подключите его к компьютеру (Pantheon II активируется только после 
распознавания компьютером IO 22). 

2. Добавьте канал FX. Для этого выберите Project > Add track > FX Channel и нажмите ярлык Inserts для FX 
Channel. 

3. Нажмите на пустой слот и выберите Earlier VST Plug-ins > Lexicon > Pantheon II. 

4. Нажмите ярлык Sends для аудиотрека, который необходимо обработать ревербератором. 

5. Нажмите на пустой слот и установите выходом FX-1 Pantheon II. 

6. Нажмите кнопку Power и установите необходимый уровень посыла. На канал FX можно подавать 
сигналы с любых треков. 
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Технические характеристики 
Микрофонные входы: XLR (F), контакт 2 — “+” 

Входное сопротивление: 3 кОм, симметричное 

Фантомное питание: +48 В 

Максимальное усиление: +58 дБ 

Эквивалентный шум на входе (при максимальном усилении): -125 dBu (сопротивление источника 150 Ом); 
-129 dBu (A-взвешенный, сопротивление источника 150 Ом) 

Максимальный входной уровень: +21 dBu при минимальном усилении

Частотный диапазон: +0/-1 дБ, 20 Гц — 20 кГц

Коэффициент нелинейных искажений: <0.006%, 20 Гц — 20 кГц (с микрофонного входа до главных выходов); 
<0.003%, 1 кГц, входной уровень +5 dBu

Линейные входы: 1/4” TRS симметричные или несимметричные

Входное сопротивление: 20 кОм симметричное, 13 кОм несимметричное 

Максимальный входной уровень: +32 dBu 

Частотный диапазон: +0/-1.5 дБ, 20 Гц — 20 кГц (относительно 1 кГц) 

Коэффициент нелинейных искажений: <0.004%, 20 Гц — 20 кГц (с линейного входа до главных выходов) 

Инструментальный вход: 1/4” TS несимметричный

Входное сопротивление: 1 МОм

Максимальный входной уровень: +13 dBu 

Частотный диапазон: +0/-2 дБ, 20 Гц — 20 кГц (с инструментального входа до главных выходов) 

Коэффициент нелинейных искажений: <0.004%, 20 Гц — 20 кГц, 0 dBu 

Линейные выходы: 1/4” TRS симметричные или несимметричные

Уровень: >+18 dBu максимум

Сопротивление: 32 Ом симметричное, 16 Ом несимметричное

Выход на наушники: стереоджек 1/4”, 350 мВт на канал при нагрузке 50 Ом

MIDI-интерфейс: 5-контактные разъемы DIN на входе и выходе MIDI (сигнал 5 В) 

Частота дискретизации: 44.1, 48, 88.2 или 96 кГц (определяется приложением компьютера) 

Динамический диапазон (частота дискретизации 44.1 кГц): А/Ц (24 бит) 105 дБ, A-взвешенный, 20 Гц — 20 кГц; 
Ц/А (24 бит) 107 дБ, A-взвешенный, 20 Гц — 20 кГц; A/Ц/A (24 бит) 102 дБ, A-взвешенный, 20 Гц — 20 кГц

Питание: сетевой адаптер 9 В переменного тока, 12 Вт

Габариты: 305 мм (Ш) x 102 (В) x 95 (Г)

Вес: 1 кг

 

* В целях усовершенствования продукта технические данные и/или внешний вид могут быть изменены без 
отдельного уведомления.
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